Cook’n User Manual

About this Manual
This manual covers many of the common features of the Cook’n software. We have
attempted to document the most common tasks, but will add more as they are needed or
requested by the Cook’n community.
This document has some conventions that you should be aware of to help you understand.


Red text indicates an action item you must click.
Example: On the drop-down menu, select Options | Add Photo.



Dark blue text refers to labels on the Cook’n screen that you are to look for, but not
click on.
Example: On the toolbar, click on Menu, then under the Cook’n Bookshelf you will find
and create your own menus.

The following image shows the common terms used throughout this manual.

2

Cook’n User Manual ......................................................................................................................................1
About this Manual .........................................................................................................................................2
Welcome to the Cook’n Family! ....................................................................................................................6
Our History ................................................................................................................................................7
What We Believe .......................................................................................................................................7
Our Core Values ...................................................................................... Error! Bookmark not defined.
Where to go for Help .....................................................................................................................................8
Cook’n Support Website............................................................................................................................8
Contact Emails ...........................................................................................................................................8
Fax .............................................................................................................................................................8
The Ultimate Kitchen Utility ..........................................................................................................................9
Electronic Cookbook ..................................................................................................................................9
Recipe Manager.........................................................................................................................................9
Menu Planner ............................................................................................................................................9
Grocery Shopping Assistant.................................................................................................................... 10
Personal Home Nutritionist .................................................................................................................... 10
Getting to know the Cook’n Start Page ...................................................................................................... 11
Toolbar Icons and Functions ...................................................................................................................... 13
Organizing your Recipes ............................................................................................................................. 15
Getting to know the Edit Recipe window ............................................................................................... 15
Entering a recipe by hand....................................................................................................................... 18
Adjust recipe serving sizes...................................................................................................................... 20
Adjust serving sizes without changing the recipe .................................................................................. 20
Embed a recipe into another recipe ....................................................................................................... 21
Save recipe to new cookbook and/or chapter ....................................................................................... 21
Copy a recipe into a new chapter........................................................................................................... 21
Open multiple tabs ................................................................................................................................. 22
Change the Theme of a Recipe ............................................................................................................... 22
Change the theme of a Cookbook .......................................................................................................... 22

3

Search and Capture .................................................................................................................................... 22
Searching the Recipe Database .............................................................................................................. 22
Capture Online Recipes .......................................................................................................................... 23
Find ..................................................................................................................................................... 23
Capture ............................................................................................................................................... 23
Capturing Recipes ............................................................................................................................... 23
Nutritional Analysis and Shopping Lists ..................................................................................................... 24
Generating a Nutritional Analysis from a Recipe ................................................................................... 24
Generating a Nutritional Analysis from a Recipe or Menu you have entered ....................................... 25
Entering Custom Ingredients and Brands............................................................................................... 25
Using Custom Units ................................................................................................................................ 27
Creating a Shopping List from a Recipe or Menu ................................................................................... 27
Menu Planning ........................................................................................................................................... 28
Menu Overview ...................................................................................................................................... 28
Creating a menu ..................................................................................................................................... 28
New Features in Version 12 ........................................................................... Error! Bookmark not defined.
Capture and share Pinterest recipes ...................................................................................................... 29
Other Features ........................................................................................................................................... 31
Importing, Exporting & Sharing Cookbooks ........................................................................................... 32
Backup & Restore ................................................................................................................................... 32
How do I email recipes? ......................................................................................................................... 33
Can I change to metric units with Cook'n? ............................................................................................. 34
How do I import photos into my recipes? .............................................................................................. 34
Printing ....................................................................................................................................................... 36
Getting to know the print preview window ........................................................................................... 36
How Do I Print My Own Cookbook? ....................................................................................................... 37
Print a Single Recipe ............................................................................................................................... 37
Technical Support Q&A .............................................................................................................................. 38
Why doesn't the Capture feature work for all websites? ...................................................................... 38
Will my old recipes and cookbooks transfer to the new version of the program if I upgrade? ............ 38

4

If I download the upgrade version of Cook'n, do I need to keep my old version installed in order to
install Cook'n? ........................................................................................................................................ 38
How do I restore a backup file? .............................................................................................................. 38
How do I email recipes? ......................................................................................................................... 39
How do I analyze nutritional values? ..................................................................................................... 39
Why is it that changing the number of servings of a recipe has no impact to the nutritional data? .... 39
I lost my cookbook. Can I re-download it again? ................................................................................... 39
I have some old Cook'n cookbooks on CD. Will these CDs work with the newest version of the
program? ................................................................................................................................................ 40
I registered for the Cook'n Club. What are my benefits, and how do I access the forum? ................... 40
Mac Support ............................................................................................................................................... 41
Trouble importing Recipe files into Cook'n for Mac: ............................................................................. 41
Cook'n for Mac won't install in my user account but will install under the admin account .................. 41

5

Welcome to the Cook’n Family!
Few things bring people together like good food. Studies show that families that eat
together stay together. I started DVO 24 years ago with the hope of bringing families
together at dinner time.
I created Cook’n with the purpose of bringing families together at meal time. Cook’n, The
Social Network for Foodies, is revolutionizing the way that people manage their recipes. The
features and benefits in Cook’n are changing lives; that’s why it made my day when Stacey
from Cape Cod, Massachusetts wrote and said, “I love this program! May God bless you for
providing a tool for me to use to help bring my family to the dinner table.”
I believe that Cook’n is the best recipe organizer in the world.
I hope to hear from you too! If you can think of ways to make Cook’n better, please let me
know. My team and I have exciting plans for the future, but making Cook’n great and
spreading the word is a team effort. I hope you will be a part of it!
Thank you for your support and thank you for spreading the good word!
Sincerely,
Dan Oaks
President
Dan@dvo.com
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OUR HISTORY
DVO Enterprises is a family software company located in Alpine, UT. DVO Enterprises was
founded in a spare bedroom by software developer Daniel V. Oaks Jr. in March of 1992. As a
student at Brigham Young University with one computer, little capital, and no connections,
Dan set out with the goal of creating quality software products to strengthen families.
Dan’s Cook’n Apps make it easy connect to and share recipes with family and friends. The
amazing Search & Capture, Scan, Menu Planning, Grocery Shopping, and Nutrition features
are making mealtime memorable and revolutionizing the recipe industry!

WHAT WE BELIEVE
The family unit is the most basic and fundamental organization in any society and the best
environment in which to develop physically, mentally, morally, and spiritually healthy people.
Tremendous forces are being exerted to weaken the family unit. The new technologies that
are emerging can have a profoundly positive or negative impact on the family's well-being.

At DVO we believe that, with God as our partner, we can change
the world. We believe life is an exciting adventure and we're
grateful for every new day. We dream big and pursue those dreams
with vigor, enthusiasm, and passion. We value innovation and
freedom. We seek help and guidance from our Creator as we
develop our God-given talents and pursue our inspired ideas. We
abhor conformity and refuse to accept mediocrity. We expect
honesty and integrity in every case and will not tolerate any other
alternative. We fear not and we doubt not...but go forward boldly
with faith and determination to succeed.
DVO Enterprises, 620 E. Windsor Ct. Alpine, UT 84004
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Where to go for Help
COOK’N SUPPORT WEBSITE
The Cook’n support website (http://www.dvo.com/support.php) is a great place to look for
video tutorials and answers to frequently asked questions. If you still need help, contact our
support team using the provided form.

CONTACT EMAIL ADDRESSES
Sales: sales@dvo.com
Cook'n Club: barbara@dvo.com
Order Status: shipping@dvo.com
Business Partnership Inquiries & Proposals: brent@dvo.com
Human Resources: hr@dvo.com
Wholesale: wholesale@dvo.com
Media/PR: media@dvo.com
Investors: investors@dvo.com
Web Comments: webmaster@dvo.com

FAX
Fax: 801-492-1291
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The Ultimate Kitchen Utility
The Cook'n Recipe Organizer is an easy-to-use program that makes recipe management and
organizing a snap.

ELECTRONIC COOKBOOK


Search thousands of recipes in seconds



Capture recipes from the internet

Simply tell Cook'n Recipe Organizer what ingredients you have on hand, and in seconds
Cook'n will suggest several delicious recipes. Or, use the exclusive "Recipe Browser" feature
in Cook’n and flip through pictures of finished dishes to look for ideas.
Download new recipes every week from dvo.com. You can also
import recipes from other web sites.

RECIPE MANAGER


Add your own recipes



Easily adjust recipe serving sizes



Print recipes on pre-formatted 3x5 and 4x6 cards or on an 8.5
x11 sheet of paper



Share recipes with friends

Organizing your family recipe collection is easy with the Cook'n Recipe Organizer. You
already know how to put in your recipes, that's because the recipe window in Cook’n looks
just like a recipe card. And, "Quick-Fill" editing does most of the typing for you.
The Recipe Organizer has simple cookbook-like chapters and categories that make it easy to
find your recipes.
The Recipe Manager in Cook’n makes entertaining a snap. Simply select the number of
guests you will be serving and enter it into your favorite recipe. Cook'n Recipe Organizer
calculates the new ingredient amounts for you. No more of that measuring madness!
Sharing recipes is easy. Print recipes on pre-formatted 3x5 or 4x6 cards, or just have Cook'n
Recipe Organizer email recipes to a friend.

MENU PLANNER
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Simply drag and drop recipes to create your menus



Build your custom menus and meal plans



Automatically generate a shopping list from your menus

You can simply drag recipes into the days of the week to create a menu. Then combine
weekly menus into monthly and even a yearly menu.
Plus, you can combine recipes and food items to make complete meals. Then, drag and drop
meals to make your own weekly or monthly menus.

GROCERY SHOPPING ASSISTANT


Compiles your family's shopping list



Organizes shopping list items by aisle



Converts to package sizes (ie; tablespoon tomato paste to 8 oz.
cans)



Calculates the cost of your recipe or menu

Cook'n Recipe Organizer automatically combines the food on your
menus and makes a grocery shopping list. It even converts tablespoons of tomato paste to 8
oz. cans! Cook'n organizes your shopping list by aisle to save you time at the store.
Cook'n Recipe Organizer also calculates the approximate cost of your shopping list. You can
sync these detailed lists to your mobile devices through the Cook’n Cloud, print them off for
easy access, or even create them on your mobile device while shopping.

PERSONAL HOME NUTRITIONIST


Analyze the nutritional elements of recipes and menus
(even the ones you add!)



Choose you preferred brands to satisfy dietary needs

Cook'n Recipe Organizer will analyze the nutritional value of
any recipe or menu (even the ones you add!). You don't have
to be a nutritionist to understand it either -- that's because
Cook'n nutrition facts window looks just like the label on a can.
Cook'n Recipe Organizer has nutrition facts from the labels of 10,000 food products. You can
choose between different brands to see what the nutritional differences are. Stop the
guesswork among different brands and know which one is most appropriate for your needs.
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The Cook’n Home Page
The following section shows the different parts of the Cook’n Homepage and describes how
to take advantage of each feature.

1. Recipe – Use the Recipe link to quickly jump to your recipes. When you click Recipe
the screen will divide into three sections. The Cook’n BookShelf, the Recipes panel, and
the main view section. Once you click on a Cookbook, Chapter, or Recipe it will be
displayed on the right screen. You can click the view tab to view your cookbooks with a
theme.

2. Favorites – The Favorites button will take you to the “Categories” Section. The
“Category” section allows you to view the recipes that you mark with a certain label
when you are creating or editing a recipe. To create new categories, click the “Edit” tab
at the top left of the main screen. Here you can create as many category labels as you
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would like. Recipes can be classified into more than one category. For example; a
recipe for pizza rolls could be classified under “Appetizers” and “Kids Favorites”.

3. Menus – You can create menus and meal plans within Cook’n. To start a new menu
click the “Menu” button from the homepage of Cook’n and switch from the “View” tab
to the “Edit” tab. You can now create your own menus. You may want to read the
section about menus and meals before starting.

4. Search – The search button opens the Advanced Search window. Here you can serach
by name, keywords, recipes with photos, prep time, cook time, etc… The search results
will appear in the bottom section of the Advanced Search window as well as in the
Recipes panel.

5. Refresh – Click to refresh your Live Recipe Feed.
6. Live Feed Settings – Here you can mange your Live Feed preferences, remove feeds,
add custom feeds, or add a Pinterest board you’d like to follow.

7. What’s New – We post updates to Cook’n frequently. Click here to see what’s new in
the latest update.

8. DVO.COM – By clicking here, you will be able to access www.dvo.com and purchase
additional cookbooks, themes, and plugins to give you a better experience with Cook’n;
as well as a chance to check out the Cook’n Club monthly newsletters

9. Recipe Search Bar – Search the internet for a single ingredient or recipe, or enter the
URL from a page with a recipe you want to capture.

10. Live Recipe Feed – The Live Recipe Feed shows you recipes that are being posted from
popular recipe websites and Pinterest accounts from all over the web.
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Toolbar Icons and Functions
Cook’n has a new toolbar with some new features. The table below describes what each
button does.

FUNCTIONS
The Home screen contains quick links to the most popular features of Cook’n,
the Cook’n Daily, and News & Updates.
Cook’n allows you to open several tabs at the same time. Viewing multiple
recipes, menus and your entire cookbook library at the same time has never
been so easy.
The New Recipe button allows you to start entering your own personal recipes
instantly.

Select the Recipes view to optimize your recipe browsing experience.

Select the Menu view to optimize your menu planning experience.

Find and organize your favorite recipes.
The List button generates a shopping list when a recipe or menu is open.
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The Nutrition button generates a nutritional list when a recipe or menu is open.

Opens the print preview for printing cookbooks, chapters, recipes, menus, or
shopping lists
Search your recipe library or search the entire internet to find the perfect recipe.

Once you find a recipe from your favorite websites click the capture button and
Cook’n will instantly import that recipe directly into your recipe library.
The Review My Library button allows you to track which of the name-brand
cookbooks you have downloaded from DVO.com
The Cook’n Cloud sync button allows you to 1) Set up your Cook’n Cloud account
and 2) Manually sync to your Cook’n Cloud once it’s set up.
The Snip-it button allows you to import a scanned recipe file (jpg, bmp, gif, png,
tiff, pdf) to make it easy to copy it into Cook’n.
The Cook’n Friends button opens a portal to your Cook’n Friend Network. Click
this button to browse your friends’ recipes.
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Organizing your Recipes
GETTING TO KNOW THE EDIT RECIPE WINDOW
The following section describes the different features of the Edit Recipe Window and
explains how each of the features work.
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1. Window Tab – You may have as many tabs open as you would like. This makes it very
easy to compare recipes. This image shows a single recipe.

2. View Tab – The view tab enables you to view the recipe embedded in one of the
custom recipe templates.

3. Edit Page – The Edit Page tab allows you to enter a new recipe, or make changes to an
existing recipe.

4. Category Page – The Category Page allows you to classify recipes into a particular
category.

5. Share button – The share button allows you to email, post to Facebook, Pin to
Pinterest, Tweet your recipe, post to Google+, get a web link, or embed a recipe.

6. Star Rating – The Star Rating allows you to classify your recipes by how much you like
them. To remove the star rating, click on the gold star that is furthest from the left.
You can search for recipes with a particular star rating on the search page.

7. Previous – Use the Previous button to scroll back through recipes. This is a great way
to flip through your recipes.

8. Next – Use the Next button to scroll forward through recipes. This is a great way to flip
through your recipes.

9. Details Section – The Details section contains the cookbook and chapter selection,
name of the cookbook, cookbook description, serving size, yield, prep time, and cook
time. The cookbook and chapter selections, name and serving size are the only ones
that are required. The other fields can be used if needed. Click the little arrow to
minimize this section.

10. Cookbook Dropdown – The cookbook dropdown allows you choose which cookbook
you would like to save this recipe into.

11. Chapter Dropdown – The chapter dropdown allows you to choose which chapter from
the selected cookbook you would like to save the recipe into.

12. Name – Name of the recipe
13. Description – The description field contains information about the recipe; for example:
Recipe author, URL of the recipe, background of the recipe, helpful hints, and tips.

14. Serves – The serving size field is a required field. The amount served determines
nutritional information and establishes a base number for the recipe in case you choose
to change the amount served. For example, if the recipe serves 8 and you want to
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double the recipe, change the amount served to 16 and the recipe will automatically
double.

15. Yield – The yield field allows you to specify how much of a particular food can be
prepared with this recipe. For example, if a cookie recipe makes 40 cookies then enter
“40 cookies” into the yield section.

16. Prep Time – The Prep Time indicates how long it takes to get a recipe ready to cook or
bake.

17. Cook Time – Enter how long it takes to cook or bake in the Cook Time field.
18. Add photo– Click here to add a photo from your files to your recipe. (Accepts jpg, jpeg,
mpg, gif, and png file types)

19. Add video– Click here to add a video from your files to your recipe. (mp4, m4v, and
mov accepted)

20. Blank space - For asthetic purposes.
21. Ingredient Listing Section – The Ingredient Listing section contains the ingredient
information fields: Quantity, Unit/Measurement, Ingredient information, Ingredients,
and the Ingredient Brand.

22. Quantity – Enter the quantity of the ingredient into this field. For example, if the
ingredient is “2 tablespoons of sugar,” you will enter the number “2” into the quantity
field.

23. Units – Enter the unit or measurement of the ingredient into this field. For example, if
the ingredient is “2 tablespoons of sugar,” you will enter “tablespoon.”
a. Do not pluralize the unit; Cook’n will automatically pluralize the unit if needed.
b. The unit field has an auto-fill feature. If you type in the letter “C” it will bring up
the word “cup” automatically. If you type in the letters “te,” teaspoons will autofill in the unit field. Use the auto-fill shortcuts to accelerate the recipe entry
process.

24. Ingredient Info – Use this field for information that describes the ingredient. If you
have a recipe that calls for 1 pound of chopped carrots, enter “carrots” into the
ingredient field and the word “chopped” into the ingredient info field. There are two
ingredient info fields, one before the ingredient and one after. If you would prefer the
recipe to read “1 pound carrots, chopped” then you can put the word “chopped” into
the second ingredient info field.

25. Ingredient – Enter the ingredients into the ingredient field. Only enter actual
ingredients into this field. If your recipe calls for “1 pound chopped carrots,” only enter
the word carrot into the ingredient field.
a. Do not pluralize the ingredients; Cook’n will automatically pluralize the
ingredient if needed.
b. The ingredient field has and auto-fill feature. If you type in the letter “M” then
the word “milk” will automatically appear. The more letters you type, the more
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accurately Cook’n predicts which ingredient you are entering. As soon as your
ingredient appears you can click the tab key on your keyboard and it will select
the correct ingredient.

26. Ingredient Info – Use this field for information that describes the ingredient. If you
have a recipe that calls for 1 pound of chopped carrots, you enter carrots into the
ingredient field and the word chopped into the ingredient info field. There are two
ingredient info fields, one before the ingredient and one after. If you would prefer the
recipe to read “1 pound carrots, chopped” then you can put the word “chopped” into
the second ingredient info field.

27. Brand – The Brand field allows you to specify what brand you would like to use for a
particular ingredient. For example, if you only use the brand “Land o’Lakes” for butter,
click in the field and select the brand from the dropdown menu. If exact nutritional
information is important to you then you will need to specify which brands you use,
because different brands will have different nutritional information.

28. Snag-it Button – Click to bring up a box, in which you can paste or type a list of
ingredients, which will be automatically divided among the ingredient listings. This
feature speeds up recipe entry.

29. Embed Recipe – Click to browse through your cookbooks, chapters and recipes to
select one. That recipe will be embedded into the recipe you are currently editing.

30. Up – Change the order of ingredients by moving the selected ingredient. Click on the
ingredient you want to move and then the “Up” button.

31. Down -- Move an ingredient down by clicking on the ingredient you want to move and
then the “Down” button.

32. Next – When you finish entering an ingredient and want to start on the next ingredient,
click the “Next” button to start a new line.

33. Insert – To create a space between ingredients, click the “Insert” button to create a
blank line above the selected ingredient.

34. Delete – Click the “Delete” button to delete an entire row.
35. Directions Section – Enter the directions of the recipe into the Directions Section.
36. Save – Save your recipe. Before you can generate a shopping list or analyze nutrition,
you must save the recipe.

37. Close – Close your recipe window.

ENTERING A RECIPE BY HAND
There are three steps to typing in a recipe in Cook’n. First you must fill out the recipe
information, and then you enter the recipe ingredient information, and last fill out the
directions for the recipe.
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1. Filling out the recipe information
a. Click the “New Recipe” icon in the toolbar.
b. Select the cookbook and chapter you would like the recipe to save to.
c.

Give the recipe a Name and a Serving Size (required).

d. Fill in the Description, Yield, Prep Time, and Cook Time (if applicable).

2. Enter the recipe ingredient information
a. Enter your ingredients. Start with your cursor in the first field under Qty.
b. Type the quantity of the first ingredient, then press the “tab” key on your
keyboard.

c.

Type in the unit for the first ingredient, then press the “tab” key.

d. If your ingredient is “chopped carrots” then the ingredient info would be
“chopped” and the ingredient would be “carrot” – if ingredient info does not
apply to a particular ingredient, you can skip it by pressing the “tab” key.

e. Type the ingredient, then press “tab”.
f.

If ingredient info does not apply after the ingredient then you can skip it here as
well by press “tab”.

g. If you have a specific brand that you use for an ingredient, you can specify it in
the brand field. When you are done entering all the information for the first
ingredient, press “tab” one more time and it will place the cursor in the first
column of the second row. You can now continue to enter the rest of your
ingredients for this recipe.

3. Fill out the directions for the recipe
a. After you finish entering all the ingredients, click inside the Directions tab and
write the directions for the recipe. (You may use simple HTML for some
formatting. However, printed recipes will display the code and not the
formatted text.)
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b. When you are finished, click the “save” button at the top or bottom of the
screen.

ADJUST RECIPE SERVING SIZES
1.
2.
3.
4.

Open a recipe.
Make sure you are in the Edit view.
Click button “Makes 1 Servings” next to the word “Serves”.
A Change Serving Size window will appear. It will show the number of people the recipe

currently serves in the “Number of people to serve” field. Type in the number of people
you want to serve.

5. Check the box “Automatically adjust recipe quantities”

6. Click OK
The quantities for every ingredient will change to reflect the change in the amount of people
to serve.

ADJUST SERVING SIZES WITHOUT CHANGING THE RECIPE
1. Open a recipe
2. Make sure you are in the Edit view
3. Click button “Makes 1 Servings” next to the word “Serves”
4. A Change Serving Size window will appear, it will have the number of people the recipe
currently serves in the “Number of people to serve” field. Type in the number of people
you want to serve.
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5. UNCHECK the box “Automatically adjust recipe quantities”
6. Click OK

EMBED A RECIPE INTO ANOTHER RECIPE
Some recipes are the product of more than one recipe. A cake recipe for example, has a
recipe for the cake and a recipe for the frosting. Follow the directions below to add a recipe
into another recipe.

1.
2.
3.
4.

Open a recipe
Click the Embed button to the right of the ingredients list.
Browse until you find the recipe you want to embed, and select it.
The name of the recipe will appear in the ingredient field. To view that recipe, click its
name. Once you click the name of the recipe a new tab will open with that recipe in the
recipe edit window.

5. To delete a recipe that you have embedded into another recipe, click on the unit field
of the row that has the name of the added recipe. Then click the “delete” button.

SAVE RECIPE TO NEW COOKBOOK AND/OR CHAPTER
If you accidently add a recipe to the wrong cookbook and chapter, you can change the
location by following these steps:

1. Open the recipe you want to change.
2. In the Details Section of the Edit View, change the Cookbook and/or Chapter of the
recipe and then click Save.

COPY A RECIPE INTO A NEW CHAPTER
1. Find the Recipe in the Recipes panel, usually found beneath the Cook’n Bookshelf
panel.

2. Right click on the recipe and choose “copy”.
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3. Find the chapter you want to copy the recipe into in the Cook’n Bookshelf.
4. Right-click on the name of the chapter and select “paste”.
5. A copy of your recipe will be added to the chapter you selected.

OPEN MULTIPLE TABS
Viewing multiple recipes is easy with Cook’n. Open several recipe windows at the same time
to compare recipes.

1.
2.
3.
4.
5.

Open a recipe.
Click the New Tab button in the toolbar.
A new tab will appear and default to the home screen.
Select a new recipe from the Cook’n Bookshelf.
You can add as many new tabs as you would like.

CHANGE THE THEME OF A RECIPE
1.
2.
3.
4.

Open a recipe
Click the Options drop-down menu.
Click Change Theme.
Browse through the different themes until you find one that you like. Then click OK.

CHANGE THE THEME OF A COOKBOOK
1.
2.
3.
4.
5.

Click on a Cookbook in your Cook’n Bookshelf.
Switch to the view tab.
Click the Options drop-down menu.
Click Change Theme.
Browse through the different themes until you find one that you like. Then click OK.

Search and Capture
SEARCHING THE RECIPE DATABASE
Cook'n provides a powerful “recipe browser” that allows you to organize and find recipes
that use the ingredients you have on hand.
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1. Click the Search icon on the Cook’n toolbar.
2. In the text box next to “All these words,” type the ingredient(s) you have on hand.
3. Click the Search button and Cook'n will list the recipes that contain all those
ingredients.

4. You may use the other features to narrow your search by only searching recipes with
photos, searching recipes with a certain rank, or searching by prep time and cook time.

CAPTURE ONLINE RECIPES
Find


Search the internet for the perfect recipe.



Enter what you have on hand and Cook'n will find a meal you can prepare.



Search your own recipe library in seconds.

Use the proprietary search engine in Cook’n to find the best recipes on the Internet. Do an
ordinary keyword search or tell Cook'n what ingredients you have on hand and Cook'n will
search the web for recipes that match. Narrow search results and sort them to help you find
the perfect dish!

Capture


Capture recipes you find on the internet directly into your recipe library



Import articles from weekly and monthly newsletters



Add decorative themes to make recipe browsing more enjoyable

When you find a great recipe on the internet, simply click Capture and Cook'n will instantly
import the recipe into your Cook'n Library. Cook'n lets you customize your recipes with
colorful themes so they look just the way you like!

Capturing Recipes

1. Search for a recipe from the Cook'n Home Page.

2. Choose a recipe that looks scrumptious from the many choices served up by the Cook'n
Search. Click the Capture button on the toolbar to Capture the recipe.
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3. Choose the cookbook and chapter that you would like to save this recipe in and select

the “save” button at the bottom of the edit window.

Nutritional Analysis and Shopping
Lists
GENERATING A NUTRITIONAL ANALYSIS FROM A RECIPE
Cook’n can produce a nutritional analysis of any recipe whose ingredients have been entered
in the corresponding ingredient fields. As an example, we’ll generate a nutritional analysis
from a recipe in The Ultimate Cook’n Cookbook. This cookbook is included with the Cook’n
software.

1. Open a recipe. In this example, we’ll choose Sweet Potato Salad from the Salads
chapter of The Ultimate Cook’n Cookbook.

2. Click the List button on the toolbar.
3. Cook’n will compile the nutritional data, and you will see a shopping list which contains
the recipe’s ingredients. Then click on the blue Nutritional Facts tab below the title
“Sweet Potato Salad Shopping List.”

4. The nutritional facts for the entire recipe are shown in the table at the right, while the
main screen contains data on individual ingredients. Drag the scroll bar to see the other
nutritional elements.

5. At the bottom of the screen, click the Settings button. Here you may adjust recipe
serving sizes and divide nutrient amounts by the number of people served. Make sure
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to check the “Divide nutrient amounts by number served” box if you want to see the
nutritional information for a single serving of the recipe you are viewing.

6. From the Settings menu, you may also choose to list only perishable items in your
shopping list or multiply the recipe by a certain factor to match a list to your needs.

GENERATING A NUTRITIONAL ANALYSIS FROM A RECIPE OR MENU
YOU HAVE ENTERED
1. Open a recipe or menu you have entered yourself.
2. Click the List button on the toolbar.
3. Cook’n will compile the nutritional data, and you will see a shopping list which contains
the recipe’s ingredients. Then click on the blue Nutritional Facts tab below the title of
the list.

4. In most cases, you won’t have any problems seeing nutritional information for recipes
you have entered yourself. However, you may sometimes see a row of * * *…, instead of
numbers, in the nutritional information lines. If you see a * instead of numbers, follow
the instructions below to display the correct information.

5. The cause of the * problem is often that Cook’n does not actually know how much of
the ingredient listed is actually in the recipe. For example, a recipe might contain one
“package” of something, but Cook’n doesn’t know how much of that ingredient is in a
package. To fix this, double-click the brand name in the Nutritional Facts tab.

6. Check the amount that the package contains. The package may contain 37 ounces, for
example.

7. Once you know the more specific amount, return to the Recipe Edit screen. In the Unit
field for the ingredient you’re dealing with, change “package” (or whatever the current
unit is) to 37-ounce box (or whatever more specific measure you have).

8. This will tell Cook’n exactly how much of the ingredient your recipe contains, and it will
begin to display the nutritional data for these ingredients correctly.

ENTERING CUSTOM INGREDIENTS AND BRANDS
Entering custom ingredients and brands is easy, but there are a few steps which you must
follow in order for Cook’n to display the nutritional information correctly.
In addition, it may seem confusing at first that nutritional data is attached to brands rather
than to the ingredients themselves. However, this allows Cook’n to reach a level of
customizability not available in other recipe software programs by making room for multiple
versions of a single ingredient, depending on what you buy.
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In this example, we’ll enter a new ingredient called “money” and a new brand called “green
stuff.” You can follow along and enter the same information into your program, or you may
replace “money” and “green stuff” with a custom ingredient and brand of your choice.

1. From the main Cook'n screen, click View at the top toolbar, then Ingredients.
2. Click on the New button next to the list of all ingredients. Enter a name for your
ingredient, and then click Save at the bottom. We'll use "money" as an example, so type
in “money” as the ingredient name.

3. Add a plural name (“moneys”). Then click Save at the bottom of the screen.
4. In the same screen, to the right of the “Brand” field, click New.
5. Add a new brand by typing it in. We'll call the brand "green stuff." When you are done
typing, click away from the brand name. A dialog box will appear asking if you want to
Quick Add the brand or choose Setup. For now, choose Quick Add.

6. Save the ingredient. Now click the brand name green stuff, then click the Preferred
button. Then save the ingredient again.

7. Open the brand window by pressing clicking View at the top toolbar and choosing
Brands. Search for “green stuff,” then click it. You should see the correct name in the
"Brand Name" box under "Brand Details" on the right side. Save the brand.

8. Add brand data for each field. Just enter “0” or another dummy value if you don’t know
everything. It’s important to fill out each field so that the nutritional information will
display correctly. The nutritional values will be on the package. After you have entered
all the information, save the brand.

9. Select a food group for the brand. Add a price, a package size with quantity and size,
and a serving size with quantity and size. Add a number in the servings per container
box too. Again, if you don't enter values here, the nutritional information will not
display correctly.

10. Save the brand again, and then close the brand window.
11. Go back to the ingredients window and save the ingredient again. Then highlight green
stuff (the brand) and click Preferred again. Then save the ingredient and close the
ingredients window.

12. Now open a recipe and add the “money” ingredient to it. First, click the Edit window to
see the data fields for the recipe.

13. At the bottom of the ingredient list, enter the quantity, units, and name of the
ingredient--for now that's "1," "ounce," and "money." "Money" should be displayed
automatically as you type it.

14. Save the recipe.
15. Click the List button at the top ribbon to see the shopping list and nutritional
information. You should be able to see "money" in the list with a best buy and an
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amount. In the Nutritional Facts tab, you will see the nutritional data that you entered
earlier.

USING CUSTOM UNITS
As with other aspects of the Cook’n software, the unit data is totally customizable, and
adding custom units is easy.

1.
2.
3.
4.
5.

Open the Units menu by selecting View and then Units.
Click New.
Enter a unit name, an abbreviation, and a plural name.
Select whether the unit measures volume or weight.
Enter an equivalence for the unit. For example, perhaps you’ve created a unit called a
“backpack full.” Since one backpack full is equal to three pounds, you would put “3 |
pound” in the “This Unit equals” line.

6. On the next line, enter the smallest measuring size for the unit – ½, ¼, etc.
7. Check the last box if you wish to use this unit when you adjust serving sizes for recipes.

CREATING A SHOPPING LIST FROM A RECIPE OR MENU
Creating a shopping list is as easy as viewing the nutritional data for a recipe.

1. Open a recipe or menu. In this example, we’ll choose Sweet Potato Salad from the
Salads chapter of The Ultimate Cook’n Cookbook.

2. Click the List button on the toolbar.
3. Cook’n will compile the nutritional data, and you will see a shopping list which contains
the recipe’s ingredients.

4. You can print this list or sync it to your cloud account for easy access on your mobile
device. You can also add items to the list with the button in the bottom-right corner.

5. You can generate a shopping list from a menu in the same way.
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Menu Planning
MENU OVERVIEW
Stop wasting time trying to find a good recipe in the piles of cards or internet print-outs
laying around the kitchen. Now you can organize them easily on your computer! With
Cook’n you can do the following:
Create your own custom menus: With Cook'n you can simply drag recipes into the
days of the week to create a menu. Choose from your own cookbooks or from the
delicious recipes that come with the program.
Build your own weekly, monthly and yearly menus: Cook'n will let you plan
ahead with your menus according to your time frame! Get organized so you can
plan the right meals for the right day or time of year. Use this tool to balance out
your family's nutrition and budget!
Automatically generate a shopping list from your menus: With a planned out
menu you can better plan your grocery shopping trips. With a click of the mouse,
you can generate a shopping list for any one of your menus and save time and effort
by not having to go to the store multiple times a week.
Print your menus and stick them on the fridge: To make it easier for your family
to see the upcoming meals on your menu plan, use new and improved printing
features from Cook'n. Customize the menu to make it look sharp and print out
weekly, monthly, or yearly versions.
Backup, restore and share: Make backups of your entire database, or just export
and share favorites with other Cook’n users.

CREATING A MENU
1. Click Menu on the toolbar. Two windows will appear to the right of the Cook’n
Bookshelf: Menu Planning (menu editor), and Cook’n Home used for viewing each
menu you select in the Cook’n Bookshelf panel.

2. At the bottom of the Cook’n panel, right-click Menus and choose New Menu or rightclick on an existing menu and choose Copy Menu. You can now edit this menu in the
Menu Planning panel in the middle.
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3. Under Menu Details, give this menu a name and any instructions or notes to describe
it. Example: “Lunches for Bobby.”

4. Under Menu Labels, drag any of the labels to the Menu box, or add labels of your
own, then drag those to the left as well.
Example: Double click on the Template for Day Menu on the left, in the Menus
list, under the Cook’n Bookshelf. In this example, breakfast, lunch and dinner have
been added to the menu.

5. Once you have assembled a list of labels under the Menu box, drag and drop specific
recipes from any of the cookbooks on the left, in the Cookbook Library, to the desired
label in the Menu box.

6. If you have a food item you want to add to a label, which isn’t in the Cookbook Library,
Use the Add Food button to create one temporarily. Note: items added this way will
not be saved in the Cookbook Library.

7. When you are finished, hit Save, and your new menu will now appear in the Cook’n
Bookshelf under the Menus list located at the bottom.

CAPTURE AND SHARE PINTEREST RECIPES
Cook’n will automatically import all of your Pinterest recipes with one click and synchronize
the two so any new recipes that you pin will appear in Cook’n.

To import your Pinterest recipes:
1. Click options>preferences>Pinterest preferences within Cook'n.
2.
3.
4.
5.

Log into Pinterest
Go to your recipe board or your list of boards.
Click the Capture button.
Cook’n will capture each cookbook from your boards and build a cookbook for you. If
you are viewing your list of boards, each chapter of the cookbook created will contain
the recipes from each board.

6. Anytime you pin new recipe to your board, Cook’n will import it for you.
To pin a recipe to Pinterest from Cook’n:
1. First click Options>Preferences and select Pinterest settings. Set up your boards.
2. Open a recipe.
3. In edit mode, click the share button (the first button on the right side above your
recipes).

4. Select “Pin it.”
5. If needed, enter your Pinterest login information
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6. Edit the description
Pin your recipe

SCAN PRINTED RECIPES
With the new Scan-it feature, it’s easy to get your printed recipes into Cook’n with having to
type!

1.
2.
3.
4.
5.

Click the Snip-It button on the Cook’n toolbar

6.
7.
8.
9.

With your mouse, highlight the title of the recipe.

Click the “Import Scanned Recipe” button
Select an image file of a recipe. You can even import photographs of recipes.
Cook’n will import the image, and convert it to text.
On the left half of Cook’n you’ll be able to make any edits that may have been
converted to text incorrectly.
In the Snip-it tool, click NAME. The title will go into the new recipe in Coo’kn.
Repeat steps 5 and 6 for Descriptions, Ingredients, Directions, etc
Click DONE in the Snip-it tool, and save your recipe.

LIVE RECIPE FEED
The Live recipe feed bring recipes posted on the internet into your Cook’n home page. You
can capture any of these recipes into your own Cook’n cookbooks.

To capture a recipe in the Live recipe feed:
1. Click a recipe that you like.
2. If you like it, click Capture
3. You can also click and hld on a reipce you like, and drag it over to a chapter. Cook’n will
automatically capture and save the recipe into that chapter.

4. You can edit your Live Feed preferences by clicking Options>Preferences
To edit your Live recipe feed:
1. Find the Pinterest username for the website you’d like to follow.
2. If the URL, for example, is www.pinterest/recipelion/pins/, the username would be
recipelion.

3. Enter the username into the “Pintereste Username” field in the Live feed preferences
page and click Go.
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4. Click the green arrow to the right of “Go” to follow every post from that User, or click a
boards and click the green arrow to add that board to your feed.

PRINT THEMES
Cook’n allows you to print your recipes with the themes of your choice. You can print full
sheets or cards with the themes.

1. Select a cookbook or recipe and click Print
2. Click Print Settings.
3. Check “Print recipe with them”

SNIP-IT FEATURE
When a recipe online is not formatted quite right, Cook’n is unable to capture with one click.
Snip-it makes it easy to enter these recipe into Cook’n.

1. Visit a recipe website in Cook’n
2. If the recipe cannot be captured automatically, a split-screen will happen. The website
will be on the left, and the new recipe on the right.

3.
4.
5.
6.

With your mouse, highlight the title of the recipe.
In the Snip-it tool, click NAME. The title will go into the new recipe in Cook’n.
Repeat steps 5 and 6 for Descriptions, Ingredients, Directions, etc
Click DONE in the Snip-it tool, and save your recipe.

SNAG-IT TOOL
Import your recipes from Word, notepad, and any other text-based program with the new
Snag-it feature.

1.
2.
3.
4.
5.

With your mouse, highlight the title of the recipe in your text program.
In the Snip-it tool, click NAME. The title will go into the new recipe in Cook’n.
Repeat steps 1 and 2 for Descriptions, Ingredients, Directions, etc
Highlight the list of ingredients.
In Cook’n, click the new Snag-it button. It’s to top button to the rigth of the
ingredients list in Cook’n.

6. Paste your ingredients into the pop-up box. Press OK.
7. Click DONE in the Snip-it tool, and save your recipe.
You can also type ingredients into the snag-it pop-up window and have Cook’n parse the
ingrients out into the recipe.
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SHARING FEATURES
With Cook’n, you can share a recipe by email, by posting to Facebook, by pinning on
Pinterest, by tweeting it, by posting to Google+, and more!

1. From any recipe page, click the share button. It’s the first button to the right above your
recipes.

2. Select the social media feature you wish to use.
3. Follow the on-screen instructions.
4.

Other Features
IMPORTING, EXPORTING & SHARING COOKBOOKS
Cook’n allows you to export single cookbooks to share with other Cook’n users or use as a
backup.

To export a Cook’n Recipe File:
5. Select the cookbook you want to export from the bookshelf.
6. With the cookbook selected, click File |Export |Cook’n Recipe File.
7. Choose a location to save the file and give the file a name.
8. Click Save. The cookbook is now exported to a file with a .dvo extension.
To import a Cook’n Recipe File:
1. Click File | Import | Cook’n Recipe File.
2. Navigate to the .dvo file and select it.
3. Click Open. Cook’n will import the cookbook and all its recipes.

BACKUP & RESTORE
You can backup, restore or transfer all your recipes at once, then restore them when needed,
or move them to another computer by doing the following:

Backup
1. Click File | Backup. Then select the location and give it a name.
2. Click Save.
You can save to your local computer, or to a flash drive or other backup device.
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To transfer all files to another computer, simply take the *.ckn file.
The default save location is C:\Users\... \Documents\Cook'n Backups
Note: Cook’n automatically backs up all your data up to five different full
backups (cooknbackup1.ckn). The newest backup replaces the last
backup. Even though Cook’n makes backups for you, we recommend that
you make backups regularly to protect your data.

Restore
1. Transfer the flash drive with the backup file from your old computer to your new
computer.
3. Run Cook'n on your new computer
4. Click File.
5. Click Restore.
6. Find the backup file on the flash drive and click OK
WARNING: Restoring from a backup file will permanently erase and replace everything in
your current Cook’n program with the contents of that backup file. If you want to merge
a recipe into your existing library, use File | Import/Export | Cook’n Recipe File.

Transferring all data to another computer
1. On the source computer create a backup file and email or save the *.ckn file to a flash
or other portable drive.

2. Open Cook’n on the destination computer and restore the same file.

HOW DO I EMAIL RECIPES?
You can send a text-formatted recipe, or a chapter in one of your books in a text format
through your email. Currently you cannot select multiple recipes.
1. Find and open a recipe you want to share

2. Click Options | Email Recipe.
Note: The recipe you are sending will appear in the Recipes field at the
bottom of the mail recipe window.
3. Type the email address of the person you want to send the recipe to in the “To” field
4. Enter a subject and short message and then click Send.

33

7. If you get the error above click OK then Setup.

3. With Use Default Settings selected, put in your full name (what you want displayed)
and your email address, then Ok.

4. If that still doesn’t work, go back into Mail Setup and select Use My SMTP Settings.
Fill out the required information. To find out what your mail provider’s settings are, do
a search on the internet for: mail setup smtp + <your mail provider’s name: Google,
Yahoo, etc>.
Note: You can email a Cookbook or an individual chapter by first selecting
the Cookbook or chapter name and then clicking Options, Email Recipe.

CAN I CHANGE TO METRIC UNITS WITH COOK'N?
To convert your recipes to metric:

1.
2.
3.
4.
5.
6.
7.

Click Units on the toolbar.
Edit Pounds.
Uncheck the box that says "Use this unit when adjusting serving sizes."
Edit Kilograms.
Check the box that says "Use this unit when adjusting serving sizes."
Repeat with teaspoons, tablespoons, ounces, and grams, liters, milliliters, etc.
Finally, open the recipe you want to convert and double the serving size and then cut
the serving size in half to return it to the original value. As Cook'n scales your recipe, it
will convert the recipe to metric units.

HOW DO I IMPORT PHOTOS INTO MY RECIPES?
Importing photos into recipes, chapters or cookbooks is easy, but there are a few things to
understand about Cook'n and photos that will help you.
Cook'n currently imports your photo exactly the way they are, meaning pixel size and
Megabyte size. It then stores the photos in your Cook'n Data. This is import because the

34

photo displayed on screen in your recipe will be the same size as the photo you took which
may be a problem if the photo came straight of your camera and is huge!
For best results you will want to resize your photos before importing them into Cook'n. You
can use any image editing software available to you to do this. We recommend a size about
600px high or 600px wide and smaller. Also save the photo as a jpeg image file at a medium
quality to keep down on the file size of the photo as well.
Cook'n will import the following image files: .jpg or .jpeg, .png, .gif, .bmp, for best results
save as a medium quality .jpg

1.
2.
3.
4.
5.

Open up Cook'n
Select the recipe you want a photo added
Select Options->Add Photo from the menu bar
Show Cook'n were the photo is saved on your hard drive
Select the type of image file it is from the drop down below and choose open
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Printing
GETTING TO KNOW THE PRINT PREVIEW WINDOW

1. Go to first – When you have multiple pages of recipes in your print preview, use this
button to jump to the first page.

2.
3.
4.
5.

Back – Use the back button to scroll backwards through your print preview pages.

6.
7.
8.
9.

Fit page to window

Display – Tell you what page of your cookbook or recipes you are viewing.
Forward – Use the forward button to scroll forward through your print preview pages.
Go to Last – when you have multip pages of recipes in your print preview, use this
button to jump to the last page.
Fit page to window width
Zoom out – Zoom to see the full page
Zoom in – Zoom out will make the recipe larger for easier viewing.
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10. Settings – click to change print settings
11. Save – Save your recipe as a PDF file
12. Print – Send the recipes to your printer.

HOW DO I PRINT MY OWN COOKBOOK?
1.
2.
3.
4.
5.
6.
7.

Open up Cook'n.
Click Recipe at the top of the screen.
Select the cookbook you want to print.
Click the print button
When Cook’n asks if you want to print recipes in the Cookbook Format, click YES
This will launch the print preview.
Cook’n will automatically create page numbers, an index, a table of contents, and title
pages for you.

8. To scroll through the recipes, use the forward and back arrows in the top left corner.
9. Click the Print button on the top right and choose the Professional Cookbook Printing
option. Your cookbook will be printed, bound, and shipped to you

PRINT A SINGLE RECIPE
1. Open the recipe you want to print.
2. Click the print button from the toolbar.
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Technical Support Q&A
WHY DOESN'T THE CAPTURE FEATURE WORK FOR ALL WEBSITES?
The recipe format differs from one site to the next. No two websites are the same! As a
result, Cook'n must be customized for each site. The Capture feature in Cook'n works well for
many of the main recipe websites but not all. This is a continuing effort. We have a team that
is working to add compatibility for more and more websites and as progress is made,
updates will be posted and the capture feature will get better and better. We are dedicated
to improving this exciting feature, even for sites that do not follow a recipe standard. Thank
you for your patience as we expand and improve this feature!

WILL MY OLD RECIPES AND COOKBOOKS TRANSFER TO THE NEW
VERSION OF THE PROGRAM IF I UPGRADE?
Yes. When you install Cook'n, it will search your computer system for an older version of
Cook'n and upgrade your recipe data automatically.

IF I DOWNLOAD THE UPGRADE VERSION OF COOK'N, DO I NEED TO
KEEP MY OLD VERSION INSTALLED IN ORDER TO INSTALL COOK'N?
Only until after you have upgraded your recipe data.

HOW DO I RESTORE A BACKUP FILE?
Cook'n makes a backup of your recipe database files automatically from time to time. These
backup files are saved in the Documents\Cook'n Backups folder. To restore a backup file,
simply run Cook'n, click File->Restore, and choose the most recent backup file. Note: If you
do this, you will be disconnected from your Cook’n Cloud accout.
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HOW DO I EMAIL RECIPES?
To keep things simple, Cook ‘n’s default settings are designed to use the DVO mail server to
send email messages. However, in some cases, access to this server is blocked. If this
happens, simply click the Setup button in the Mail Recipe window and check the "Use My
SMTP Settings" check-box. Enter your Username, Password, etc. You may need to contact
your email Service Provider to get this information. We would do this for you if we could but
we cannot because we don't know this information or have access to it. After you enter this
information, Cook'n will email recipes for you!

HOW DO I ANALYZE NUTRITIONAL VALUES?
Analyzing nutritional values can seem complicated at first. The easiest way to master this
powerful aspect of Cook'n is to watch the Nutritional Analysis Explained video
demonstration.

WHY IS IT THAT CHANGING THE NUMBER OF SERVINGS OF A RECIPE
HAS NO IMPACT TO THE NUTRITIONAL DATA?
Since the recipe quantities always increase proportionately to the number of people the
recipe serves, it can sometimes appear as if changing the number of servings has no impact.
For example, if a recipe that serves 5 people has a total of 500 calories (that's 100 calories
per serving) and you double the serving size, the recipe now serves 10 people and has twice
as many calories; a total of 1000 calories which is still 100 calories per serving.

I LOST MY COOKBOOK. CAN I RE-DOWNLOAD IT AGAIN?
Please send an email to barbara@dvo.com and tell her which cookbook you need to redownload. She will look up your order records and re-send a link for you.
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I HAVE SOME OLD COOK'N COOKBOOKS ON CD. WILL THESE CDS
WORK WITH THE NEWEST VERSION OF THE PROGRAM?
Yes. Follow these steps:
1. Insert the CD. Note: Close any dialogs that open automatically
2. Run Cook'n and click File |Import
3. Browse to the CD drive and double-click the import.dvo file

I REGISTERED FOR THE COOK'N CLUB. WHAT ARE MY BENEFITS, AND
HOW DO I ACCESS THE FORUM?
The Cook'n Club product on the Thank You page of our shopping is linked. Clicking this link
will take you to a page with all the information you need. If you already closed this window,
that's OK because an email message with this link is automatically sent. Simply check your
email. If you need additional help, send an email to barbara@dvo.com
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Mac Support
TROUBLE IMPORTING RECIPE FILES INTO COOK'N FOR MAC:
Cook'n for Mac will import Cook'n recipe files (.dvo) and restore Cook'n backup files (.ckn) in
the Cook'n version 9, 10, 11, and 12 format. Files created with Cook'n version 8.2 and below
will NOT import into Cook'n for Mac.
For those of you that have files created with an older version then version 9 of Cook'n the
easiest solution is to follow this step by step process below.
Install Cook’n on a WINDOWS computer.
Import or restore your recipes. This will convert them into the Cook'n10, 11, and 12 format.
(choose file | import or file | restore from the file menu)
Create a backup file by selecting file | backup or just select a cookbook and choose file |
export | Cook'n Recipe File and move that newly created backup (.ckn) or (.dvo) file to
your mac computer.
Open Cook'n for Mac and choose file | restore for a .ckn file. Choose file | import | Cook'n
Recipe File for a .dvo file.
Cook'n 9 trial for PC: http://www.dvo.com/upgrade/
If you continue to have trouble please email us at macsupport@dvo.com

COOK'N FOR MAC WON'T INSTALL IN MY USER ACCOUNT BUT WILL
INSTALL UNDER THE ADMIN ACCOUNT
To fix this problem you need to allow your individual account to have administrator
privileges.

1. Click on the apple icon on the top left of your screen and from the dropdown menu
select system preferences option.

2. Under the System section near the bottom there is an option called Accounts the icon
is two people. Select it.

3. In the Accounts window simply check the box that says Allow user to administer this
computer (see picture for example). If the option is grayed out, select the locked icon
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at the bottom left of the window (see picture example) Enter in the admin username
and password to unlock, then check the box
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